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1.0 Introduction 
The GLIMS project aims to collect geospatial information about the glacier ice-
cover of the entire world.  The University of Alberta, under the direction of Dr. 
Martin Sharp is participating in the GLIMS project by contributing geospatial 
information about glaciers in the Canadian high arctic islands.   
 
The GLIMS project was originally designed with mid-latitude alpine glaciers in 
mind.  Consequently, GLIMSView software works well for isolated alpine 
glaciers, but is awkward for the large ice-caps and ice-sheets that are found in 
the Canadian high arctic islands.  Ice-cap/sheets in the arctic are much larger 
than alpine glaciers, and may extend for hundreds of kilometres.  They tend to be 
composed of many ice-drainage basins and have many outlet glaciers and 
termini.  If an arctic ice-cap/sheet was included in the GLIMS database as a 
single glacier the simple attributes that are available for glacier description in 
GLIMSView would not be adequate for the many margins, termini, sources, etc. 
of an arctic ice-cap/sheet. 
 
For this reason the GLIMS community has decided to break arctic ice-
caps/sheets up into ice-drainage basins.  The GLIMS glacier classification and 
quantification will then be carried out on an individual glacier-basin that 
represents all the confluent ice flow from an ice-cap/sheet to a single terminus.  If 
need be, an ice-caps/sheet can easily be studied by merging all its component 
ice-drainage basins (Figure 1). 

 
Figure 1 - Ice-cap divided into ice-drainage basins in which all ice is flowing toward one 
particular glacier terminus. 

The following procedure has been developed as a step-by-step guide for 
delineating arctic ice-drainage basins, classifying their respective attributes in 
GLIMSView, and uploading them to the GLIMS database.  The procedure 
outlined here differs markedly from the procedure that would typically be used for 
an isolated alpine glacier because of the complexity and scale of arctic glaciers. 
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2.0 Basic Setup 

2.1 Step 1 - Organize 
Create a folder under your own name on the GLIMS2 server (map network drive 
to GLIMS2 server along the following path: entire network > eos_labs > eoslweb1 
> GLIMS2).  You will keep current copies of all your files here.  Create folders 
and organize the data in a hierarchy that makes sense so that someone else 
may access your work.   A hierarchy may be organized as follows: island/ice 
sheet name > data types (shapefile, raster), data progress (GLIMS prep, GLIMS 
ready, GLMS output), etc. 
 

Example:  
In the GLIMS2/Greg/Axel/Raster folder there are Landsat 
images of Axel Heiberg Island (onsaxel_ls99_z17_b1-5_subset 
which contains the 30m Landsat visible/NIR data, 
onsaxel_ls99_b8 which contains the 15m Landsat panchromatic 
data and onsaxel_ls99_b542 which contains bands 5, 4 and 2).  
There is also a folder containing a DEM. 
In the GLIMS2/Greg/Axel/Shapefiles folder there are shapefiles 
of the ice extents in 1960 (from aerial photographs) and 1999 
(from Landsat imagery).  There are also many shapefiles 
(basin1 to basin629) that delineate ice-drainage basins of the 
main ice sheet (based on the 1999 ice outline). 
In the GLIMS2/Greg/Axel/GLIMS_ready_basins folder are the 
same basin shapefiles as above except that they have been 
formatted to be compatible with GLIMSView, i.e. they have 
been projected in the WGS1984 geographic projection. 
In the GLIMS2/Greg/Axel/GLIMSoutput folder are the final 
GLIMSView output files that are ready to be merged together 
and uploaded to the GLIMS database. 

2.2 Step 2 - Download 
Visit the GLIMS website (http://www.glims.org/) and download the most recent 
version of GLIMSView software, and the GLIMS glacier classification manuals.  
Print the manuals because you will need to reference them frequently.  Install the 
GLIMSView software. 

2.3 Step 3 - Install 
If it is not already loaded onto your machine, install ArcView 9.x.  You may need 
to speak with the EOSL lab manager (Mei Mei Chong) or, the department’s 
technical assistant for help installing this program.  ArcView 9.x is superior to 8.x 
for GLIMS work because it is more stable, and introduces fewer inconsistencies 
when drawing shapefiles.  Operation of version 9 is similar to 8 except that many 
tools have been placed in the ArcToolbox. 
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Notes: 
1. If you are familiar with ArcView 3.x, please refer to Appendix One of this manual.  

Advanced users of version 3 will not have difficulty delineating ice-drainage 
basins, but, for the intermediate user version 9 will be faster and easier. 

2.4 Step 4 - Find the data 
Map network drive to the old GLIMS server (entire network > eos_labs > 
Eoslserv1 > GLIMS) and locate the files you will need for the particular ice-sheet 
you are working on.  These files will likely include: 1) the satellite imagery for the 
area (usually several files or a mosaic), 2) the 1960, and 1999 ice-outlines of the 
ice-sheet, 3) a DEM of the island you are working on, and 4) any ice-drainage 
basins that have already been created for the ice sheet (several ice sheets have 
only been partially completed).  Copy the files you need from the old GLIMS 
server to your space on the GLIMS2 server.  
 
You are ready to begin ice-drainage basin delineation in GIS! 
 
Notes:   

1. You may have to dig around a bit to find all the files that exist for a particular ice-
sheet.  Please remember that many different people have been working on the 
GLIMS project part-time, and everyone has a different filing system.  If you are 
not sure what has been done, ask others in the research group and check the 
GLIMS glacier viewer (on the GLIMS website) to see if the ice-sheet you are 
about to do has not already been uploaded. 

2. Most GLIMS-related files are located in the “GLIMS_databasing” folder on the 
GLIMS 1 server.  However, useful files and images may be located in other 
folders on this server.  The “Ice_outlines” folder contains ice outline shapefiles 
that have been produced from the 1960 and 1999 images.  The “Fiona” folder 
contains another folder called GLIMS where many GLIMS-related files may be 
found. 

3.0 Ice-Drainage Basin Delineation in GIS 

3.1 Step 5 - Make the map 
Start up ArcView 9.x and select a new empty map.  Add the 1960 and 1999 ice 
outlines for the ice-sheet you are working on.  Also add the satellite image or 
images, if more than one is required.  If ice-drainage basin delineation work has 
been partially completed for this ice-sheet, add the completed basins.  Find the 
DEM for this area and add it too.  Organize the layers by dragging them so that 
the ice-outlines are on top of the basins, which are on top of the images which 
are, in turn, are on top of the DEM (Figure 2). 
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Figure 2 - Basic map set-up. 

Open ArcCatalogue and insert a new, empty polygon file in the directory in which 
you will be creating your ice-drainage basin polygons.  Add the empty shapefile 
to the map and leave the filename as “newshapefile”. 
 
Right-click the layers text at the top of the layer menu and select map properties.  
Find the coordinate system and change it to UTM, North American Datum 1983 
and select the UTM zone that you are working in.  GLIMSView only accepts 
shapefiles that are WGS 1984 geographic, but it is much easier to work in UTM 
when using ArcView.  You will change the projections of all the shapefiles that 
are destined for input into GLIMSView later. 

3.2 Step 6 - Adjust the map for drainage basin delineation 
The 1999 ice-outline has been created by remote sensing and edge detection 
and completely surrounds the ice-sheet that you are working on.  Your job is to 
break this ice-sheet up into ice-drainage basins.  An ice-drainage basin is a 
portion of the main ice-cap/sheet in which all the ice is flowing toward one 
particular glacier terminus.   
 
To break the ice-cap/sheet into ice-drainage basins, you will need to know the 
direction in which ice at any one point on the ice-cap/sheet surface is flowing.  
Information that will guide you as you determine the direction of ice-flow may 
include: flow banding and debris trains on the ice surface that are visible in the 
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satellite image, the slope of the ice surface as defined by the DEM, and the 
general shape of the portion of the glacier that you are analyzing. 
 
For the purpose of delineating ice-drainage basins, the most important elements 
are the ice-outlines, the satellite image, and the DEM.  These elements must be 
adjusted so that the information they portray can be viewed simultaneously.  
They must also be adjusted so that the information in one layer compliments that 
in the others.  ArcView is a powerful program for visualizing and organizing 
geospatial data.  There are many adjustments that may be made to the layers in 
a map.  The adjustments one makes will depend on personal preference, or on 
the data that is being viewed. 
 
The layers can be adjusted by right-clicking on the layer name in the layer list 
and selecting properties.  Most of the display choices can be found under the 
symbology and display tabs.  The display options for a raster image or DEM, for 
example, are almost limitless.  The data may be classified or stretched.  
Histograms for stretched display can be infinitely adjusted (although several pre-
defined choices are available).  Almost any colour combination can be used to 
display every map element.  The transparency can be adjusted so that one layer 
is visible through another.  Shapefile polygons can be displayed as filled or 
hollow, and the outlines can be thick or thin, and coloured infinitely. 
 
In Figure 2 for example, the 1999 ice outline polygon is displayed with a blue line. 
The polygon is not filled in, because we need to see the satellite image and DEM 
below this layer.  The ice outline provides the raw shape of the ice-cap/sheet 
which must be broken into ice-drainage basins.  The satellite image is displayed 
as a grey-scale with high contrast which allows easy visual separation of light 
and dark, or glacier ice and bedrock/debris.  Flow lines and ice limits stand out 
under this arrangement.  The image has also been made 30% transparent so 
that we can see the DEM below it.  The DEM is displayed as a colour-gradient of 
highly contrasting colours (warm colours for high elevation, cold colours for low 
elevation).  This gives us an easy visual indication of altitude, and can not be 
confused with the image which is composed of contrasting grays.  The DEM has 
been made 50% transparent so that it does not over-power the image. 
 
Creating contour lines to display elevation data is a useful alternative to 
displaying the data as a classified or stretched colour gradient.  This may be 
especially useful if the satellite image is coloured (red-green-blue).  You may 
construct contour lines with the 3D analyst.  Open view > tools and check the 3D 
analyst.  Click the 3D analyst button on the toolbar and select surface analysis, 
and then select create contours.  Store the file in a sensible location.   
 
Add the file to the map and open the ArcToolbox.  You will now clip the contours 
to the ice-extent so that the contours look clean and less of your computer’s 
processing power is used to render (display) the shapefile.  Select analysis tools, 
then extract and then clip from the ArcToolbox menu.  Use the contour file as the 
layer that is to be clipped, use the 1999 ice outline as the layer that the clip is to 
be based on.  Store the output file somewhere that makes sense.  Right-click on 
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the original contour layer in your map and remove the layer.  Add the new clipped 
layer (if it is not already added).  The contour line shapefile has been cut to the 
dimension of the ice outline.   
 
In Figure 3, the DEM has been turned off (unchecked), and the elevation data is 
displayed solely by the contour lines.  The same warm to cool colouring system 
is used to differentiate the contour lines.  The satellite image is 0% transparent, 
providing better resolution than the map in Figure 2.  ArcToolbox is open showing 
the path to the clip function. 
 

Figure 3 - Elevation displayed as contour lines.  Full resolution of satellite image. 

Spend some time adjusting your map with the layer properties dialogue boxes 
until you have to data arranged in such a way that you can determine ice-flow 
direction with confidence. 
 
Notes; 

1. Please be mindful that DEM’s in arctic regions have large cell sizes, and often 
contain errors.  The DEM should only be considered as a rough approximation of 
relief.  If the DEM relates information that seems to contradict what you see on 
the image, default to the image for ice-flow direction. 
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3.3 Step 7 - Delineate the first ice-drainage basin 
Familiarize yourself with the ice-cap/sheet that you are working on by navigating 
around the map and try to conceptualize the general ice-flow patterns.  Begin by 
selecting an area where you are confident that you know exactly how the ice is 
flowing.  Open the view, select toolbars and check the editor.  Open the editor 
and select start editing.  A dialogue will appear where you will select your empty 
polygon “newshapefile” as the edit target.  Check the “newshapefile” box so that 
the polygon will be visible and adjust the layer (right-click, properties) so that it is 
hollow, and its border is easily identified.  Set the editor toolbar task menu to 
create new feature and click the pencil.  Draw the polygon around the ice-
drainage basin you wish to delineate.  Double-click to finish drawing. 
 
Figure 4 shows a rough outline drawn around an ice-drainage basin.  Contour 
lines and flow lines on the ice-cap’s surface have been used to separate this 
basin from its neighbors. 
 

Figure 4 - Rough basin outline drawn. 

Adjust the rough outline by selecting the pointer from the editor toolbar.  Double-
click the polygon border to show the nodes that may be moved or deleted.  If 
need be, more can be added by right-clicking the line.  As per Figure 4, try and 
get the line positioned accurately where it crosses glacier ice on an ice-divide.  
Simply place the line outside of the 1999 ice outline where it falls adjacent to the 
margins or terminus of the ice-drainage basin.  When you are satisfied with your 
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polygon, select the editor drop down menu from the editor toolbar and select 
save edits, then select stop editing. 
 
Now you must clip the “newshapefile” to the extent of the 1999 ice outline.  You 
will follow the same procedure that you used to clip the contour lines in section 
3.2.  Open the ArcToolbox and select analysis tools, then extract and then clip.  
Use “newshapefile” as the layer that is to be clipped, use the 1999 ice outline as 
the layer that the clip is to be based on.  Name the output file something like 
“basin1” and store it somewhere that makes sense.  The cut-out is automatically 
loaded into your map, and as shown in Figure 5, the “newshapefile” has been cut 
to the dimension of the ice outline.  Start the editor again specifying the 
“newshapefile” as the editing target.  Select the outline of “newshapefile” with the 
pointer and delete it.  You are going to re-use this shapefile to create the next 
ice-drainage basin, and you don’t want any part of it left-over from “basin1”. 
 

 
Figure 5 - “basin1” is clipped from the “newshapefile”. 

Notes: 
1. If you find that the 1999 ice-outline is not accurate, you may edit the outline the 

same way that you would edit any other shapefile.  This is true for ice-
margins/termini, and especially nunataks within the ice-cap/sheet.  To exclude a 
nunatak area from the ice-outline you must arrange the ice-outline shapefile such 
that the nunatak appears through a hole in the ice-outline.  Do this by grabbing 
two nodes of the ice outline and overlapping them so a loop is formed.  Select cut 
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polygon features from the editor menu to cut the loop free.  Edit the loop so that it 
defines the nunatak area and re-shape the edge from which you cut the loop. 

2. Make any modifications to the ice-outline in an area where you are about to 
define an ice-drainage basin BEFORE you define the basin.  This will save you 
extra work. 

3. If the basin you are delineating has nunataks isolated within it you must push the 
explode multi-part feature button on the advanced editor toolbar. Do this while 
you are in an edit session, but after you have clipped the basin from the 1999 ice-
outline.  This will ensure that the nunatak outlines are not attached to the basin 
outline surrounding them. 

4. If point 3 above doesn’t work, you can isolate nunatak outlines from the main 
polygon by using AcrCatalog to create an empty polyline shapefile.  Open 
ArcView with a new empty map and add the empty polyline and the polygon 
shapefiles to the map.  Turn on the editor and copy & paste the polygon into the 
polyline.  Hit explode multi-part feature when the polyline is highlighted.  Convert 
the polyline projection to WGS 1984 and move the file to the GLIMSReadyBasins 
folder.  Name the file accordingly. 

5. Remember that you are delineating ice-drainage basins, not water-drainage 
basins.  Ice flows plastically whereas water flows fluidly.  Several programs, 
including ArcView 9.x will model fluvial drainage basins, but these models are 
based on flow following the steepest path.  Ice does not always follow the steepest 
path.  Furthermore, arctic ice often terminates in a piedmont or lobe while a 
fluvial drainage basin will terminate at a point.  Lastly, the DEM is often wrong 
causing any model based on it to also be wrong. 

3.4 Step 8 - Delineate the rest of the ice-drainage basins 
With a few extra steps, you may follow the procedure outlined in section 3.3 to 
delineate the rest of the ice-drainage basins.  The extra steps will ensure that any 
new ice-drainage basin that you delineate will adjoin the existing ice-drainage 
basins exactly in places where they share a common boundary. 
 
To do this you begin creating the ice-drainage basin by editing the 
“newshapefile”.  Click the editor menu and select snapping.  Select the vertex of 
the neighbor ice-drainage basins as the snap-to targets.  In Figure 6, the vertex 
of “basin1” has been selected.  Start creating the basin by editing the 
“newshapefile”.  You will notice that when your cursor approaches a node of 
“basin1” it will go to it automatically like a magnet.  You can adjust the degree of 
“magnetism” in the editor options dialogue.  You can zoom in an out while editing 
and you may need to zoom in to ensure that common boundaries between 
“newshapefile” and existing basins match exactly.  When you have finished 
creating your basin, adjust the “newshapefile” layer so that it is hollow, and the 
border is thin.  Then you can zoom into areas of common boundaries to ensure 
that there are no slivers, overlaps or gaps.  Problems are common in areas 
where 1) the shape is complex, 2) where two basins adjoin and abut against an 
area of rock, 3) in areas where ice-drainage divides are separated by a nunatak, 
and 4) where nodes are placed very close together. 
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Figure 6 - The second basin borders the first.  The common boundary is snapped together 
so no gaps, slivers or overlaps exist (inset). 

Now you must clip the second basin following the procedure you used for the first 
as outlined in section 3.3.  Call the basin “basin2” and store it in the same folder 
where you stored “basin1”.  Continue delineating ice-drainage basins until the 
entire ice-cap/sheet is completely covered.  If you find that too much processing 
power is being used to render all the basin shapefiles, you can remove shapefile 
layers from your map that are not adjacent to the area in which you are currently 
working. 
 
Notes: 

1. Notice that the second basin in Figure 6 is formed from two confluent glaciers.  In 
this case we define the basin as one, because a basin represents all the ice that is 
flowing toward a single glacier terminus. 

3.5 Step 9 - Merge the basins together into one shapefile 
At this point you have probably created several hundred drainage basins.  To 
check the integrity of your data you could add all the drainage basins to your map 
and look for any parts of the 1999 ice-outline that are not covered by an ice-
drainage basin.  This is effective but rendering so many shapefiles at once 
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demands a lot of computing power and is very slow.  Since you will probably 
want to view your entire dataset many times, it makes sense to merge all the ice-
drainage basins into one large shapefile that can be rendered quickly, and turned 
on and off easily. 
 
Merge the basins by opening ArcToolbox.  Select data management tools, then 
select general and then select append.  Add all the basins you have created as 
input features.  Select your “newshapefile” as the output feature, or the feature to 
which all the basins will be appended (make sure you have edited the 
“newshapefile” such that it is empty or clean).  You can then re-name the 
“newshapefile” as something like “icecapmerge”.  Figure 7 shows the merged 
basins for Axel Heiburg Island. 
 

Figure 7 - Merged basins for Axel Heiburg Island. 

3.6 Step 10 - Change the projection of the basins 
All the ice-drainage basin polygons you have created thus far have a projection 
that is either UTM, or undefined.  This must be changed because the GLIMSView 
software that you will use to assign attributes to your ice-drainage basins will only 
accept shapefiles that are in the WGS 1984 geographic projection. 
 
To change the projection of a shapefile you must open the ArcToolbox and select 
data management tools, then select projections and transformations, then select 
feature, then select batch project.  Add all your drainage basins as input features, 
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and select an output workspace for the newly projected shapefiles to go.  Click 
the button next to the output coordinate system and choose select, then choose 
geographic coordinate systems, then choose world, and select WGS1984.prj. 
 
Notes: 

1. The output workspace for the newly projected shapefiles should be a separate 
folder from the one in which the basin shapefiles currently reside.  You will want 
to separate the WGS 1984 geographic projected shapefiles from the undefined or 
UTM projected shapefiles.  Creating a folder entitled “GLIMSReady” is 
appropriate because these shapefiles are ready to be imported into GLIMSView.  
This folder should be created at the same level in the folder hierarchy as the 
original basin shapefiles folder so that the data progress can be assessed in one 
view of your file navigator. 

2. Some shapefiles will require that their projection be defined before they can be 
re-projected.  If this is necessary, select define projection from the ArcToolbox 
menu and assign the projection as whatever it currently is.  You can find out what 
a shapefile’s current projection is by right-clicking on it in the layer menu and 
opening properties, then selecting source. Alternatively, you can find out the 
current projection by viewing the metadata of a shapefile in ArcCatalogue. 

3. Sometimes the batch process doesn’t work.  It may be necessary to project each 
shapefile individually, or in small batches. 

3.7 Step 11 - Save and back up everything you have done so far 
Congratulations! You have finished delineating drainage basins for an ice-
cap/sheet and you are ready to begin assigning attributes to the basins using 
GLIMSView.  Do not forget to back up your data in a separate location from the 
one in which you have created it.  If you have been working on the GLIMS2 
server, copy everything you have done to your folder on the D:\ drive of the 
machine you are working on. 

4.0 Assigning Glacier Attributes in GLIMSView 
The free-ware program GLIMSView will be used to assign attributes to the glacier 
drainage basins you have created.  GLIMSView is not as sophisticated as 
ArcView, and in many ways the current version is insufficient for assigning 
attributes to arctic ice-drainage basins.  For example, if you were to import all the 
ice-drainage basins for a particular ice-sheet at once, you would have trouble 
assigning attributes to any one basin because you can not specify the edit target.  
In areas of common boundaries, you would not be able to identify or control 
which boundary you are editing.  For this reason, among others, you will import 
and export one basin at a time from the GLIMSView edit session. 
 
GLIMSView always exports files with the same file names.  To prevent 
GLIMSView from overwriting your last basin with the current one, you need to 
create separate output folders for each of your basins.  Create one folder for 
every basin that you have delineated and give the folder the basin name.  Place 
all of these folders in a higher-level folder that is entitled something like 
“GLIMSOutput”. 
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4.1 Step 13 - Configure the glacier basin in GLIMSView 
Open GLIMSView.  Select project and then select create new project.  When the 
dialogue box appears, browse for the satellite image you used in ArcView.  Load 
the various bands with a red-green-blue combination that highlights the glacier 
ice.  Alternatively, and if it provides a better visualization, load a grayscale of the 
image.  Close the band chooser.  Push the gear button to open the configuration 
window.  Select window and choose tile to arrange the windows in a tile pattern.   
 
Practice navigating in GLIMSView by zooming in and out of the various windows 
and dragging the zoom box around in one window as it controls the view in the 
other.  The “whole view” window stays “as is”, and provides an overview of your 
current location. 
 
Select project, then select import/export, then select import generic shapefile.  In 
the dialogue box that appears, browse for the WGS 1984 geographic projected 
“basin1” file that you have recently created and import it.  Navigate the map so 
that the “basin 1” is completely contained within the fixed window, and the zoom 
window shows a zoomed view of the glacier source area. 
 
Select glacier config from the configuration window and press the green “ID” 
button on the toolbar.  You are now going to put a point feature within the source 
area of your glacier-basin by clicking within the basin outline.  Try and put the 
point over thick, source-area ice.  The database is being created for posterity, 
and if you put the glacier ID in a position from which the glacier will retreat in 20 
years, the ID is useless.  Notice that a glacier ID (GID) appears in the 
configuration window when you put the point on the map.  This is the GLIMS ID 
for “basin1”.  All information about this glacier basin will be identified with this ID 
from this point forward.  Figure 8 shows a properly adjusted GLIMSView screen, 
with a glacier ID set in an appropriate position. 
 
Press the line button followed by the pointer button.  Select the outline of “basin1” 
by dragging the pointer across it, and press the set lines button in the 
configuration window.  Highlight the GID of “basin1” (only one GID should be 
available) and press apply.  What you have just done is assign the same GID to 
every segment of your basin.  Now the basin segments and all associated 
attributes can be identified by the GID. 
 
Highlight the glacier ID in the configuration window.  Press the edit glacier ID 
button to open the glacier ID dialogue box.  The options available in this dialogue 
box will be used to describe your glacier basin.  Most descriptors are available 
through drop-down menus, but others you must enter manually.  At this point, 
you should consult the glacier classification documentation that you have 
downloaded from the GLIMS website.  Familiarize yourself with the choices that 
are available and classify the glacier as accurately as you can.  It is understood 
that not every glacier basin can be pigeon-holed into the short list of categories 
that are available, but please try and be consistent with your choices. 
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Width, length and area of a glacier basin can be calculated in ArcView.  Also, the 
tongue activity must also be assessed in ArcView by comparing the 1999 ice-
outline with the 1960 ice-outline.   
 
Notes: 

1. It is helpful to keep ArcView running at the same time that you are doing the 
GLIMSView work so that you can assess these attributes easily.  It is best to work 
on a computer with two monitors so that you can run GLIMSView on one and 
ArcView on the other. 
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At this point you should refer to the GLIMS documentation to understand the 
meaning of the choices that are.  However, Figure 9 shows a particular line 
config matrix that was used on several arctic ice-caps with success.  You may 
wish to copy this arrangement. 
 

 
Figure 9 - A useful line config matrix. 

The first row is used to describe a glacier ice-drainage divide that is internal to 
the ice-cap.  The second row describes the lateral margin of a glacier basin.  The 
third row describes a glacier basin terminus.  Row four describes an area where 
a glacier ice-drainage divide abuts against a nunatak.  The nunatak separates 
two glacier ice-drainage basins, thus the text “glac_bound” is found under the 
glacier type column and not “intrnl_rock”.  If you use “intrnl_rock” to describe a 
nunatak that separates two ice-drainage basins, the program will not be able to 
recognize the perimeter of the basins.  All basins must be defined on their 
outside perimeter by segments that are all categorized as “glac_bound”.  Row 
five is used to describe nunataks that are enclosed completely in a glacier basin.  
Note that row five has the text “intrnl_rock” in column two.  The program will not 
try and associate the internal rocks with a glacier boundary perimeter, but 
instead, will keep these rock outlines with the glacier basin in which they lay.  
Row six describes a glacier that terminates in water.  Row seven describes a 
glacier margin that is flanked by water (such as an ice-marginal lake).  Row eight 
describes a glacier head (such as a cirque headwall).  Row nine is used for any 
segment that does not fit into any available category.  Row ten has not been set 
up, and contains only the default attributes that it was originally assigned.  Row 
ten is not used at all in this example. 
 
The screen-shot in Figure 10 provides a closer look at the line config edit 
dialogue box. 
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Figure 10 - Line config edit dialogue box. 

The first option glacier type is where you will define the type of boundary you are 
drawing.  The choices that you make here will depend on the level of detail that 
you wish to include, but please remember that every ice-drainage basin must be 
enclosed by “Glacier Boundary” lines.  All internal rocks that do not separate ice-
drainage basins must be enclosed by “Internal Rock” lines.  The “Basin 
Boundary” definition is for bedrock basins - something that is generally not 
defined for the massive arctic ice-sheets. 
 
The segment type option can generally be assigned as “Measured”.  This is 
because the ice outlines have been created by remote-sensing and computer 
processing and thus, are very accurate. 
 
The materials left and materials right options refer to what is on the left and right 
of the line you are drawing.  ArcView 9.x draws polygon lines in a clockwise 
direction.  Thus you must assign the materials to the right and left accordingly.  If 
you have created the basin polygons in ArcView 3.x, refer to Appendix One for 
information about determining the direction of a line. 
 
The features left and features right options are selected in a similar fashion to the 
materials left and materials right options. 
 
The local uncertainties options may all be set to zero.  This is because we have 
not assessed what our uncertainties are.  A value of zero is the same as a null 
value in the GLIMSView database. 
 
The display options may be set according to personal preference. 
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You may wish to set up all the line config options before you begin assigning 
attributes to various lines, or you can set up the line config options while you are 
assigning the attributes.  The latter option is recommended because it will allow 
you to make choices based on what you actually have in the data, rather than 
making the choices based on what you think you may have.  The line config 
options can develop organically under this circumstance.  Expect the fist few 
basins to go rather slowly while you fine-tune the line config options, but once 
adjusted, this process will be very quick as you assign pre-defined lines to your 
glacier basin outline segments. 
 
To assign attributes to a line segment you will begin by pressing the line button, 
followed by the pointer button on the GLIMSView toolbar.  Then click and drag 
the pointer across the glacier basin outline to highlight the outline and its nodes 
as shown in Figure 11. 
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Figure 12 - Blue segment has been given ice-divide attributes. 

Continue breaking out and classifying segments until every segment has been 
assigned attributes.  Figure 13 shows how the example ice-drainage basin 
should be classified. 
 

 
Figure 13 - A properly classified ice-drainage basin. 
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In Figure 13 the lines represent segment attributes as follows: the blue line 
represents an internal ice divide; the yellow line represents a lateral margin; the 
red line represents a glacier terminus; the solid purple lines represent nunataks 
that separate ice-drainage basins; and the dashed purple lines represent 
nunataks that are completely enclosed within an ice-drainage basin. 
 
Notes: 

1. GLIMSView is very touchy.  If you try and select a node and the pointer is not 
directly above the node, it will suck the node towards the pointer, thereby 
changing the shape of your basin. 

2. You can undo a mistake in GLIMSView by pressing CTRL-Z. 
3. If you need to join two line segments, you can do so by highlighting the two loose 

ends and pressing the weld button (next to the break button). 
4. You can draw segments in GLIMSView by pressing the line button. 

4.3 Step 15 - Export the completed basin from GLIMSView 
Now that the ice-drainage basin’s glacier attributes and line attributes have been 
defined, export the data by selecting project, then import/export and finally export 
GLIMS shapefile from the GLIMSView toolbar.  Choose the “basin1” folder that 
you have already created for the GLIMSView output. 
 
If you navigate to this folder with your file navigator program, you will see that it 
contains many files that are generally organized under the headings “glaciers”, 
“segments”, “image”, and “session”.  There is a .dbf (database) file under each of 
these headings that contains most of the information for the basin that you have 
assigned to it in GLIMSView.  If you open the “glaciers” .dbf, you will see a 
database that contains the glacier classification information that you have 
entered, although here, it is in numerical format.  If you open the “segments” .dbf, 
you will see a database that contains the segment classification information that 
you have entered, also in numerical format.  You can change values here, but 
you must refer to the GLIMS manuals for an explanation of the numerical format. 
 
Notice that every line segment has the same GID as the glacier with which it is 
associated.  The GLIMSView database will use the GID to keep line segments, 
segment attributes, and glacier attributes together. 
 
Eventually you will merge all the “glacier” files and “segment” files for every basin 
into one large file.  After the merger, the “glacier” and “segment” .dbf files will 
contain a number of rows corresponding to, respectively, the number of glacier 
basins and segments that you have created.  Ignore the “image” and “session” 
files for now.  These files need only be updated once for the entire ice-cap.  The 
“image” files describe your satellite image.  The “session” files refer to the person 
who did the glacier classification (that’s you) and the process by which they did 
the work. 
 
When you have finished exporting the data, select every line on the GLIMSView 
display and delete them.  Then press the green GID button, followed by the 
pointer button and select the green GID dot.  Delete this feature as well.  You are 
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going to import, process, and export the next basin.  Because GLIMSView 
exports everything on its screen at once, you must not have any GID dots or 
segments left over from an older glacier classification session. 
 
Continue ad nauseam until every ice-drainage basin is done. 

5.0 Validate the Data in GIS and Prepare it for Upload 
into the GLIMS Database 
Now that attributes have been assigned to the ice-drainage basins, they must be 
merged, corrected, and transformed into a format that can be ingested by the 
GLIMS database. 

5.1 Step 16 - Merge the data using GIS 
Open ArcCatalogue and created two new empty shapefiles; one in point data 
format and the other in polyline data format.  Place these new files at the same 
level in the hierarchy as the folders which contain the GLIMS output data.  Name 
the point shapefile “glac_mrg”; name the polyline shapefile “seg_mrg”. 
 
Open ArcMap and set up a new empty map.  Choose the WGS 1984 geographic 
projection and call the map something that makes sense like “GLIMSOutput”.  
Open the ArcToolbox and select data management tools followed by general 
followed by append.  In the dialogue box that appears add, as input features, 
each of the “glacier” shapefiles from the GLIMS output folders.  Select the 
“glac_mrg” shapefile as the output feature or, the feature to which the input 
features will be appended.  Execute the merge. 
 
Follow the steps outlined above to merge the “segments” shapefiles for every 
basin.  Choose the new “seg_mrg” file as the file to which the input features will 
be appended. 
 
Add the “seg_mrg” file and the “glac_mrg” file to your map and remove all other 
segment and glacier files.  Save the map. 

5.2 Step 17 - Validate the data (basic) 
Now the data must be validated.  GLIMSView is a poor tool for manipulating 
shapefiles.  The program, most likely, will have generated errors in both the 
shapefiles and the .dbf files.  The data can be validated using ArcMap.  Open the 
map that you have just created in section 5.1 to begin validating the data. 
 
There are many aspects of the data that are worth checking, but most 
importantly, you want to ensure that the polyline shapefiles outlining the glacier-
basins were not altered from the original polygon shapefiles during the 
GLIMSView editing session.  You also want to ensure that the attributes you 
assigned to each line segment and glacier have been exported correctly from 
GLIMSView. 
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Begin validating your data by giving it a general “once-over” check.   Add the 
“icecapmerge” polygon shapefile that you created in step 9 (section 3.5) to your 
map.  Adjust the map such that the “icecapmerge” layer is under both the 
“seg_mrg” and “glac_mrg” GLIMS output shapefiles.  Navigate around the map to 
see if there are any areas where the “seg_mrg” polylines are not directly over the 
“icecapmerge” polygon boundaries.  If you happen to find errors in the polyline 
shapefile, you can correct them by editing as you would edit any shapefile.  
Specify the “seg_mrg” polyline as the edit target and specify the “icecapmerge” 
polygon’s vertices as the snap-to target.  Now you may snap the misaligned 
polylines back to their original positions as per the polygon boundaries.  While 
giving the data a “once-over” check, you may also wish to look for missing glacier 
ID points, extra unidentified polylines, or anything else unusual. 
 
If everything looks good during the “once-over” check, and there are no glaring 
problems, it is time to begin checking the data more thoroughly.  Right-click the 
“glac_mrg” layer and open its attribute table.  The attribute table of any shapefile 
is the .dbf file that you will find associated with the shapefile if you navigate to its 
location in the file hierarchy.  You may scroll through the attribute table and 
search for errors.  You may also edit the attribute table directly if the editor is 
turned on, and the file you are trying to edit is specified as the edit target. 
 
Errors you may find in the “glac_mrg” attribute table may include 1) missing data 
(identified as a zero value where a zero value is inappropriate) and 2) corrupted 
data (generally hard to identify).  Replace and repair missing and corrupted 
values. 
 
Notes: 

1. GLIMSView may corrupt the data that you have entered for length, width and 
area by shifting the decimal point such that there is one digit to the left of the 
decimal and all the rest are on the right regardless of what the original number 
was.  This is extremely frustrating, and there is no easy fix.  You will have to go 
back to ArcMap to re-measure/calculate these values.   

2. Zero is the default for a null-value in GLIMSView.  Therefore zero may be an 
appropriate value for many fields.  However, GLIMSView tends to “loose data”.  
The program then replaces the lost data with a zero value - BEWARE! 

 
When the “glac_mrg” file has been repaired begin checking and repairing the 
“seg_mrg” file.  Open its attribute table and check for missing and/or corrupted 
data as you did for the “glac_mrg” file. 
 
Errors you may find in the “seg_mrg” attribute table may include 1) missing data 
(identified as a zero value where a zero value is inappropriate) and 2) corrupted 
data (generally hard to identify).  Replace and repair missing and corrupted data 
as you did with the “glac_mrg” file. 
 
Notes: 

1. GLIMSView may randomly drop the GID from individual segments.  Scroll 
through the attribute table to identify segments with a missing GID.  If you should 
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find any, you can highlight them individually in the attribute table, then right-
click on the “seg_mrg” layer name and click selection, then click zoom to 
selected feature.  Now you can identify the proper GID by finding the GID dot 
that corresponds with the polyline that is missing its GID.  Click the identify 
button on the ArcMap toolbar and click the GID dot.  The GID will be available 
in the box that appears. 

2. Again, beware of zero values. 
 
At this point, the values for both the “glac_mrg” file and the “seg_mrg” file have 
been corrected.  However, the “seg_mrg” polylines likely have geometry errors 
that you did not identify during the “once-over” check; because they were not 
visible at a small scale (i.e. the displacements are only visible when you are 
zoomed way in).  Open the attribute table of the “seg_mrg” file and highlight all 
the segments that correspond to a particular GID at once, starting with the first 
group of segments.  Right click on the layer name of “seg_mrg” and click 
selection, followed by zoom to selected feature.  Now you can check to see if the 
polylines form a closed polygon (this is essential).  You can also check to see if 
the polylines match the polygon outlines more thoroughly than you did during the 
“once-over” check.  Edit as required.  Do this for every group of segment 
polylines. 
 
Notes: 

1. The snap function that you use to ensure polylines join other polylines or 
polygons at their vertices works best when the snapped line and the snap target 
are in the same projection.  Re-project shapefiles with different projections.  
Change the map projection as necessary to ensure that the snapping is accurate. 

 
Now that the missing/corrupted data has been replaced/repaired and the 
geometry has been, for the most part, corrected, you can perform a few basic 
visual checks on your data using the display features in ArcMap.  Open the 
properties dialogue of the “seg_mrg” shapefile.  Under the symbology tab select 
categories and choose unique values.  In the value field choose “label”.  Note 
that the choices in the value field are the same as the headers in the attribute 
table.  Click add all values to add the segment labels to the list.  You can adjust 
the colours of the segment to correspond with the colours that you used in the 
GLIMSView glacier classification sessions.  Click OK. 
 
Your map will now display the “seg_mrg” polylines with colours corresponding to 
the segment label.  Navigate around the map to ensure the integrity of your data.  
If anything is labeled incorrectly, you can edit it in the attribute table. 
 
Following the procedure outlined above, display the polylines according to their 
“category” values.  The category should be one of two choices, “glac_bound” and 
“intrnl_rock”.  Remember that “glac_bound” polylines should completely surround 
every ice-drainage basin, and “intrnl_rock” polylines should define nunataks that 
are contained entirely within an ice-drainage basin.  Navigate around the map to 
ensure the integrity of your data and edit as necessary. 
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5.3 Step 18 - Validate the data (advanced) 
The data is nearly ready for submission.  However, there are almost certainly, 
geometry problems still associated with the polylines.  You can perform more 
thorough geometry checks using visual basic scripts (small programs) that 
people have written to solve just the type of problems that you are encountering. 
 
Open your web-browser and go to the ESRI support centre homepage 
(http://support.esri.com/).  Note that you can search both the “knowledge base” 
and the “downloads” pages for scripts and instructions that will help you deal with 
many problems that the default ArcMap tools aren’t capable of dealing with. 
 
Some common geometry problems that are probably present in your data are 
dangles and slivers.  Dangles are simply polylines whose ends are not snapped 
to other polyline ends.  Slivers are small gaps between polylines where the 
polylines should abut exactly.  Search these terms in the “knowledge base” and 
“downloads” pages to see how others have dealt with these problems. 
 
Since the “knowledge base” and the “downloads” pages are constantly being 
improved and updated, it would be pointless to provide a list of useful scripts 
here.  However, one useful download is called “X-Tools”.  This is a suite of 
helpful tools that you may download for a free 30-day trial after which you must 
buy the program.  The tools are useful enough that the purchase is worthwhile 
(talk to your supervisor).  For instance, “X-Tools” will find dangles quickly if you 
use the convert polylines to polygons function.  Because “X-Tools” can’t make a 
polygon out of polylines with dangles, it will identify the dangles with a graphic.  
Then you can easily find and repair the dangle.  “X-Tools” will also calculate the 
area of a polygon or many polygons at once.  Thus you could use the tool to 
calculate all the areas of your “icecapmerge” file at once.  Then you could simply 
join the “area” column from the “X-Tools” output with your “glac_mrg” file and you 
would not have to individually enter the area values during the GLIMSView 
glacier classification session. 
 
Benefit from the knowledge and experience of others by utilizing the information 
that is available on the ESRI support centre homepage. 
 
You have now done as much with the data as you can possibly do.  If errors 
remain in the data, there is very little chance that you can find them without help.  
Luckily, the people at the National Snow and Ice Data Centre in Boulder 
Colorado (The GLIMS people) have developed software that will identify errors in 
GLIMS data. 
 
Notes: 

1. Running some of the visual basic scripts requires that you know how to use the 
visual basic editor that is commonly available with Microsoft programs and 
ArcMap.  Spending some time to learn how to run this feature is worthwhile. 
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5.4 Step 19 - Upload the data to the GLIMS database 
Locate the “glac_mrg” file and the “seg_mrg” file using ArcCatalogue.  Change 
their names to “glaciers” and “segments” respectively.  In the same folder, add 
copies of any “image” and “session” files from one of the GLIMSOutput folders.  
Open the .dbf files for the “image” and “session” files and add/correct as much 
information in the various fields as you possibly can. 
 
Navigate to the location of these files with your file navigator.  Select all files that 
are associated with the “glaciers”, “segments”, “image” and “session” files and zip 
them together.  Call the .zip file something that is related to the ice-cap/sheet you 
have been working on. 
 
Make e-mail contact with Bruce Raup (braup@nsidc.org) at the National Snow 
and Ice Data Centre and introduce yourself as the new GLIMS technician at the 
U of A.  Inform Bruce that you would like to upload completed GLIMS data.  
Bruce will likely provide you with a GLIMS ID and password that will give you 
access to the GLIMS ftp site. 
 
Open you web browser and go to the GLIMS ftp site 
(http://glims.colorado.edu/submissions/).  Note that the University of Alberta is 
GLIMS Regional Centre 3.  Follow the steps on this webpage to upload your 
zipped data.  You will come to a page that asks for specific information about the 
image processing method.  Enter the following information… 
 
General Image Data 

• Make data available immediately 
• Geocoding - YES (i.e. the image has lat/lon detail attached) 
• Georegistration - NO (i.e. no ground points used to register the image - not 

enough in the way of suitable locations on an ice cap!) 
• Orthorectification - NO (i.e. elevation data not accurate enough and 

topography not severe enough to merit this) 
• DN to radiance - YES (i.e. radiometric conversion carried out prior to us 

getting the imagery) 
• Sun elevation - NO (i.e. no attempts made to correct for solar angle - most 

of our images are summer, early afternoon when the sun was relatively high 
in the sky) 

• Relative radiometric - NO (i.e. we did no additional radiometric correction) 
• Atmospheric - NO (i.e. Arctic air is clean enough and the atmosphere thin 

enough not to require this for our purposes) 
• Anisotropic - NO (i.e. no efforts made to accommodate different reflectance 

characteristics for different surfaces as most of our interest is snow/ice) 
• Slope-aspect - NO (i.e. consideration made of shadowing on slopes) 
• Band ratio - YES (i.e. Normalized Difference Snow Index applied in order to 

discriminate ice boundaries) 
• Spatial filtering - YES (i.e. small ice masses below a threshold size 

identified by classification removed) 
• Texture analysis - NO (i.e. no discrimination of ice based on textural 

differences to non-ice) 
• Manual - YES (i.e. cleaning up of lines) 
• % lines - you know how much you did, but I would say 10-15% 
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• Supervised classification - NO (i.e. no classification of regions based on 
training samples of specific known pixel types) 

• Unsupervised classification - YES (i.e. classes determined on the basis of 
their similarity statistically using ISOADATA algorithm) 

Process Description 
• Landsat ETM+ images of the area were mosaiced using definable ground control 

points. A Normalized Difference Snow Index image was created (band2-band5 / 
band2+band5). A ratio image of band2 / band5 was created and added to the 
NDSI image. An unsupervised classification (ISODATA) with two classes was 
run on the combined image to discriminate snow/ice from non-snow/ice. Small 
areas of less than 0.1ha were removed from the classified image and a 
minimum filter run on the resulting image. The raster product was vectorised 
and cleaned up manually - the majority of this cleaning being to remove the 
outlines of small snow patches, amend the outlines of some internal rocks 
and clarify ice/water boundaries.  

Analysis Tools 
• GLIMSView 
• ERDAS-Imagine 
• ESRI-ArcGIS 
• ENVI 

 
Bruce will perform several checks on the data that you cannot perform.  Quite 
likely, he will find errors that he will identify for you.  You will then correct these 
problems and re-submit the data. 
 
Congratulations!  You have completed your task.  You have also provided 
the climatology/glaciology world with important data now, and into the 
future. 
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Appendix One 

Notes for drainage basin delineation for the Arctic ice caps 
using ArcView GIS 3.3 
 
By Fiona Cawkwell 
 
Create a folder in GLIMS2 under your name where, for now, you can keep all your work.  
In this folder there are Landsat image files of Axel Heiberg 
 onsaxel_ls99_z17_b1-5_subset which contains the 30m Landsat visible/NIR data 
 onsaxel_ls99_b8 which contains the 15m Landsat panchromatic data 
 onsaxel_ls99_b542 which contains bands 5, 4 and 2 which are optimum for this 
A folder containing the DEM data in the UTM zone17 format 
Shapefiles of the ice extents in 1960 (from aerial photographs) and 1999 (from Landsat 
imagery) 
There are also two Arc extension files (SnapThemes and snap_adv) which need to be 
copied into the C drive of the computer you are using C:/ESRI/ARCVIEW/EXT32 
 
Preparation 
Open ArcView GIS - for the first time – with a new view – subsequently with an existing 
project 
Change the working directory to be the one where your data are stored 
 File – Set Working Directory – x:\greg 
Add some extensions  

File – Extensions – check : Geoprocessing, IMAGINE support, Snap Theme 
v1.0, Advanced Snapping Tool 

For the first time add data to the view 
 View – Add Theme – Feature Data Source – Axel_ice_1960 and 1999 
 View – Add Theme – Image Data Source – Axel542 

View – Add Theme – Grid Data Source – Axel_z17 
Change both the shapefiles to show just outlines 

Double click on filename - double click on coloured box – on fill palette select 
unfilled box and from colours, outline, e.g. green/blue – apply 

Make both shapefiles active by checking box beside name 
Make image file active by checking box beside name 
Increase number of classes in DEM 

Double click on filename – click on Classify – change number of classes to 30 
– ok – apply 

Change order of layers so DEM is at the bottom, image above that, shapefiles on top 
Set the View units  
 View – Properties – Map Units = km, Distance Units = m 
 
Work – focus on the main ice cap to start off with and use the DEM and image 
texture to delineate drainage basins 
Create a polygon roughly approximating to drainage basin area 
 View – New Theme – Polygon – z.shp 
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Click on the draw polygon icon 
Draw rough outline of basin on the display 

Make the Axel_1999 layer selected 
Click on the Axel_1999 filename 

 Theme – Start Editing – Save Edits to z.shp 
 Click within the Axel_1999 ice outline on the display 
Clip the boundaries of the basin polygon to the 1999 ice outline 

View – Geoprocessing Wizard – Clip one theme – next – Input theme = 
z1.shp, Overlay theme = Axel_1999.shp, Output file = basin1.shp – 
finish 

Refine the basin boundaries 
 Turn off (uncheck) z1.shp 
 Turn on (check) basin1.shp and change to just an outline 
 Theme – Start Editing – Save Edits to Axel_1999.shp 

Zoom to active theme 
Select the vertex edit tool 
Click within the basin1 outline on the display 
Move mouse cursor over vertex box and click and drag or delete to create 

basin of the desired shape 
If you make a mistake press Ctrl-Z to delete last change 
Theme – Stop Editing – Save Edits 

Click on z1.shp 
 Edit – Delete Theme 
Double click on basin1.shp and select the filled box option 
Repeat ad nauseum until the ice cap is complete! 
 
Other useful things to know 
Make sure there are no gaps between adjacent drainage basins, or between basins and the 
margin, by snapping the vertices together with the basin theme active 

Click on Snapping icon – Enable Snapping – Theme to snap to is either 
another basin or Axel_1999.shp – Snap to vertex – Set snapping 
tolerance to 100 –set 

Right click on image – select TTools Set Snap Theme – choose theme to snap 
to (as above) – ok – Snap to Vertex – ok 

When you drag a vertex a circle will appear marking the 100m buffer so 
make sure that the vertex to which you are snapping is within the 
circle 

To clear selected features (when the basins are yellow the image) click on the clear 
features icon 
Save the work you do as a project 
 File – Save Project – x:\greg\axel.apr 
 
To edit GV files in Arc 
open segments.shp 
run xyz2xy .ave script to convert to 2d file 
open Convert Polyline to Polygon extension 
run check dangle nodes to identify points of non-joined ends 
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snap dangles back together working through dangles in attribute table selecting one at a 
time to ensure all are done. 
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Appendix Two 

GLIMSView Procedures (Older Version) 
 
By R. Wessels 
 
Glimsview is an multi-platform application designed for manual digitization of glacier 
features into a ingest ready format for the GLIMS-NSIDC glacier database.  This 
document briefly outlines a typical work flow, then demonstrates the specific steps used 
to digitize glaciers. 
 
Glimsview was designed to be the base application that will later incorporate automated 
digitizing algorithms developed by the GLIMS Algorithms working group. 

 
Work flow outline for creating ingest ready shapefiles 
 
1. Project -> New to open a new georeferenced image to start a new session 
2. Tools -> Open config to setup line types  
3. Digitize whole glacier polygon using line tool  
4.  Insert glacier IDs 
4. Assign a glacier ID to the polygon 
5. (Optional) Break polygon into specific types of segments related to segment label 
types, etc. 
6. Enter ancillary data in appropriate database fields 
7. Save project to a unique directory (Please save often as the current version has no 
autosave feature!) 
8.  Check the shapefiles using any shapefile viewer/editor 
9.  Compress the project folder and send to NSIDC for ingest 
 
Step by step recipe for creating an ingest: 
 
            GLIMS view supports ASTER HDF-EOS and all formats supported by the 
GDAL library.  It has been successfully tested using ASTER L1B, Landsat 7 (NLAPS, 
FastL7A and Geotiff).    
            On Windows:  run gv.exe in the gvbin folder 
            On unix:  run glimsviewer in the gvbin folder 
 
1. Open a georeferenced image 
 
            To start a new session, open a new georeferenced image to be digitized: 
                        Project -> New    choose an image to display 
                                    Choose file for ASTER, *** for NLAPS, any*.tif for L7 geotiff, 
and *** for FastL7A  
                        Band Chooser window opens and displays all available bands 
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-Chose one band for grayscale;  
-For Color, check COLOR box, then select the Red band, select the Green band, and 
select the Blue band (of the same dimensions), click “Load Bands” 
 
-Whole View, Fixed, Zoom View windows may be moved and resized as desired.  Select 

Window > Tile to make the image windows completely file with glimsview 
window space.    
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Image > histogram opens the histogram to adjust contrast stretch each displayed band.  
To change the default stretch, double-click the diagonal line to make a new node.  
The node(s) can be moved to create a custom piecewise stretch.   

 

 
 
2. Configure line types in GLIMSLineTool (or import predefined 
attributes) 
 
            Before one can begin to digitize, various line types and attributes need to be 
defined to represent the types of glacier features and boundaries seen in the image.  The 
global.ldf file in the gvbin folder is used to provide basic boundary types.  Each Regional 
Center or User may modify and add to these types and export the new user defaults to a 
new global.ldf file (remember to make backup of the original). 
 
To begin setting up the session, select from the main menu:          

 
Tools> OpenConfig:       

The Configuration window appears: 
                        The user may edit default line types, create new line types, or import a 
previously exported line file. 
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Select an existing line to “Edit” or click “New” to create a new line type entry.  
Line types may be created or changed at any time during a digitizing session. 

<!--[if !supportEmptyParas]--> <!--[endif]--> 
See the GLIMS data dictionary for notes regarding database field requirements at: 
http://www.glims.org/db_design.html 

 
 
3. Digitize whole glacier polygon using GLIMSLineTool 
 
For each glacier, the user must first digitize the whole glacier as a closed polygon.  The 
polygon may be divided into several specific segment types after the glacier ID has been 
assigned. 
 

To begin digitization, choose the “Activate line layer” icon   
 
   Choose a line type in the line configuration window. 

Select the left mouse button for each point to digitize in the polygon 
                        To close the polygon Select  Control-Right Mouse button 
 
            Each node on the polygon line may be moved using the “Selection Tool” arrow.  
First drag a box over the line to be selected.  All of the nodes on that line will be 
highlighted as open circles.  Individual nodes may be selected by a left click.   
 
Nodes may also be inserted by first selecting the node where insertion is to begin, then 
click the “Activate Line Layer” icon, the left click the mouse where new nodes are to be 
inserted. 
 
Selected nodes may be deleted by first selecting the node, then press the delete key on the 
keyboard.   
 
**User Tip:    Use "Control-Z"  to undo your last edit if you make any mistakes.  
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4. Create and Assign a glacier ID to the polygon 
 
The minimum requirement for the glacier info is a Glacier ID based on the 
Latitude/Longitude position of a user selected center point on the glacier.  This point may 
be selected from the image, or manually entered by the user based on another source.   

 
A glacier ID is created using the “Activate GID Layer” icon in 

main toolbar.  After the icon is selected, each left mouse click in any of 
the image viewers will add a new point to the view.  Each point represents 
a new glacier ID (GID) that is automatically created and displayed in the 
“Glacier config” tab of the configuration window.  

 

 
 
            To relocate a glacier id,   

drag a selection box over the point to select it,  
left click the selected point when the cursor changes to a cross-

hair,  
drag the point to a new location (the GID changes to reflect the 

new lat/lon).   
 

 
 
Fill in the remainder of the Glacier ID form now, or add the information later 

using “Edit Glacier ID.”   
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Select “Add” to add the ID and close the window. 
To assign a Glacier ID to a digitized feature or  features, use the selection arrow 

to drag a selection box to select glacier polygons and other features associated with one 
GID.  All node points in a feature will be visible when selected. 

 
When all features related to one glacier are chosen,  

Select the appropriate Glacier ID from the Glacier Config list 
Press the “Set Lines” to associate the Glacier ID to those features 

 
NOTE:  Previously defined Glacier Ids with centers located off the current image may be 
manually entered using the “New Glacier ID” button.  Simply enter the coordinates in the 
Lat and Lon fields and other associated data, then click “Add”.  The new GID will appear 
in the GID list, but no point will appear in the viewers.  Currently, manual edits of lat/lon 
values of GIDs that were selected using the viewer IP tool will not move the visible point 
in the viewer.  This deficiency is related to an ASTER legacy issue.   We will be 
addressing this in a future release of glimsview. 
 
5. Break polygon into specific segment types related to segment label 
types, etc. 
 
Again, we strongly recommend that each glacier outline be first digitized as one 
continuous polygon.  After the polygon is created and a Glacier ID is assigned, more 
detail about each glacier boundary may be specified by breaking the polygon into 
separate segments, each with its own attributes.  
 
For example, if the interpreter wanted to add more attributes to only the terminus of a 
glacier:  

Select the polygon to reveal the line nodes 
Select a node for the start of the terminus 
Break (Ctrl-B or the “BL” icon) the polygon at this node 
Repeat for the other end of the terminus segment 
Select the new terminus segment 
Create or edit a terminus line type that describes the pertinent attributes 
Select that line type in the line configuration list 
Press “Change Line” to apply the new attributes to the selected segment. 

 
6. Enter ancillary data in appropriate database fields 
 
The Session and Image Info tabs contain several more fields that require input for a 
complete GLIMS Database ready file set. 
 
The Session tab contains several REQUIRED fields about the interpreter name, data 
source, and processing description.  The "3D info Desc:" field is used to describe where 
height (Z) information was obtained for each point.  This field is not required if only 2D 
data were used. 
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            The “Image Info” tab allows the input of the Acquisition Date/Time.  This is done 
automatically for ASTER L1B data in the BETA version. 

 

 
 
7. Save project to a unique directory 
 
Each project from a GLIMSView session is stored in a unique directory.  The directory 
contains GLIMS database transfer shapefiles and a “gvdataset.xml.”  DO NOT CHANGE 
THE FILENAMES of files within this directory.  Only the directory name should be 
changed. 
 
The newly digitized data must be saved using “Project->Save As” from the main toolbar.  
When the “Find Directory” window appears, “Create New Folder” and click the “New 
Folder 1” to rename it for the new dataset.  Hit  “Enter” on the keyboard to change the dir 
name.  Click “OK”  
 
8.  Check the shapefiles using any shapefile viewer/editor 
 
The newly created .shp files may be viewed using any application the allows the viewing 
of shapefiles ( Arcview, ArcGIS, ERDAS, ENVI, ArcExplorer [Free], etc ).  Check the 
attribute tables for completeness and fill in missing items as needed.  Check that each line 
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segment listed in the table has an associated GlacierID.  Save these changes to the same 
shapefile. 
9. Compress the folder and send to NSIDC for ingest 
 
After the files have been checked, they are ready to send to NSIDC for ingest into the 
GLIMS database.  We suggest that the folder be first compressed into one archive.  For 
example, in Windows, one may simply drag and drop the folder onto the Winzip (or 
similar app) icon and give a filename for the new archive.  In unix, enter “tar cfz 
newarchivefile.tgz  projectfoldername”.    There are several other ways to accomplish 
this.  Please see your local computer support for further help.  After the archive(s) is 
created, notify Bruce Raup (braup@nsidc.org) to arrange for the transfer. 
 
Please send questions or bug reports to rwessels@usgs.gov or braup@nsidc.org 
 
***Last changed on 6/6/03 by RLW*** 
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